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Topics:
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• Access a Graph

   

© 2020 General Electric Company  1



Overview of the Graphs Module
Graphs provide a visual representation of data, and are used throughout GE Digital APM. Graphs can be
created and modified on the Graph page, but are used throughout GE Digital APM.

Each graph can be created based on a query or dataset. When you create a graph, you will select the type
of graph that you want to build and the information that you want to display. At least one field in any
graph must be numeric.

Any values that you want to see in a graph must be returned by the query or included in the dataset on
which the graph is based. Any changes that you make to the underlying data will be reflected in the graph.
For example, if you build a graph based on a query that returns the repair costs for each pump in your
system, and then create a new Pump record, the next time you view the graph, the data for the additional
Pump will appear.

Note: If you remove information from the underlying query or dataset a field that is included in the graph
(e.g., you remove the field on which the x-axis is based), the next time that you try to open the graph, an
error message will appear, indicating that the information is not valid.

After you create a graph, it appears in the Graph Result workspace. You can view and modify areas on
the chart by accessing the Settings pane.

Access the Graphs Page

Procedure

In the module navigation menu, select Tools > Graphs.

The Graphs page appears, displaying a table of graphs.
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Note: Graphs created or accessed from the Graphs page appear in the table. The table contains the last
25 graphs that were accessed.

Access a Graph

About This Task

This topic describes how to access a graph from the Graphs page. In the Graphs page, you can access a
graph that was recently accessed or search for a graph that is stored in the catalog.

Procedure

• Access a graph that was recently accessed.

1. Access the Graphs page.
2. In the table, in the Path column, select the link in the row that contains the graph that you want to

access.

Tip: To access the graph in a new, view-only page, in the Graphs page, in the View Graph column,
select the link in the row that contains the graph.

The Graph Result workspace appears, displaying the graph.
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• Access a graph from the catalog.

1. Access the Graphs page.
2. Select Browse.

The Select a graph from the catalog window appears.
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3. Go to the folder that contains the graph that you want to access.
4. Select the graph that you want to access, and then select Open.

The graph appears in the Graph Result workspace.
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Chapter

2
Workflow
Topics:

• Core Analysis: Graph Analysis
Workflow

• Start
• Design a Graph
• Run the Graph
• Review Graph Results
• Opportunity Exists?
• Manage Performance

Recommendations
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Core Analysis: Graph Analysis Workflow
Core Analysis processes leverage GE Digital APM data to identify opportunities for business improvement.
When the process identifies such an opportunity, a Performance Recommendation is raised to
communicate the need and track the required work. You can use the Graph Analysis Workflow process to
identify opportunities or needs for improvement based on generated graphs that identify bad actors or
high-impact failures.

In the following workflow diagram, the blue text in a shape indicates that a corresponding description has
been provided in the sections that follow the diagram. For more information, refer to the topic
Interpreting the Workflow Diagrams.

Start
Persona: Analyst

To satisfy a specific business problem, a GE Digital APM User initiates a core analysis that applies standard
data analysis techniques.

Design a Graph
Persona: Analyst

To satisfy a specific business need, design a graph to display specific data from GE Digital APM entities.
Graph design is based on predefined query designs.

Run the Graph
Persona: Analyst
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Execute the graph to produce results, and modify the graph design to achieve the desired result.

Review Graph Results
Persona: Analyst

Analyze the graph results. The graph can identify bad actors or high-impact failures for further analysis. In
the analysis of graph results, consult other forms of GE Digital APM data.

Opportunity Exists?
Persona: Analyst

If a GE Digital APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work. Otherwise, the
workflow ends.

Manage Performance Recommendations
Persona: Analyst

If a GE Digital APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work.

Go to the Manage Performance Recommendations workflow.
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• Modify the Colors of a Graph
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Graph
• Export a Graph
• Delete a Graph
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About Graphs
This topic provides a listing of all overviews and high level explanatory information to help you understand
graphs.

About the Types of Graphs
The following table describes the graph types that are supported by GE Digital APM.

Graph Type Button Useful For...

Bar Graphs

Stacked Column Comparing a set or series of values to the

same scale, unit of comparison, or range

of time. The information on a bar graph is

represented by vertical or horizontal bars.

Stacked Bar

Clustered Column

Clustered Bar

Color Scale Graph

Line Graphs

Line Identifying trends by comparing a series

of values. The data that is displayed on a

line graph is represented by a line whose

peaks and crevices indicate changes in

the data.

Area Identifying trends by tracking a series of

values measured against a set scale. The

information in an area graph is displayed

in linear form.
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Stacked Area Identifying trends by tracking a series of

values measured over time or other

category data. The information in a

stacked area graph is displayed in linear

form.

Pie Graph

Pie Comparing a portion of the data to the

whole. For example, you could use the pie

graph to determine the percentage of

energy that is used by a particular piece

of equipment or group of equipment.

Doughnut Comparing portions of the data to one

another. For example, you could use a

doughnut graph to determine which

manufacturer's centrifugal pumps are

most active.

Pyramid Displaying hierarchical structure of data.

For example, you could use a pyramid

graph to display the contributing factors

to a failure arranged in the order of

magnitude.

Radar Graph

Radar Displaying multi-source values as they

relate to one another. For example, you

could use a radar graph to compare your

allocated versus budgeted spending,

where you can also view the level of

spending per expense category (e.g.,

marketing and salaries). The data in a

radar graph is displayed in a plot that

resembles a spiderweb.

Filled Radar

Scatter Plots

Scatter Comparing a series of x and y

coordinates, and identifying relationships

between values in an x, y coordinate. For

example, you could use a scatter plot to

view the cost of repair by failure date for

a group of equipment.
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Bubble Comparing a series of x and y values with

z sizes, and identifying relationships

between values of different sizes in an x, y

coordinate. For example, you could use a

bubble plot to view the cost of repair by

failure date for a group of equipment,

where the bubble marker size is

determined by the criticality indicator for

each piece of equipment in the group.

Stock Graphs

Line Comparing the trend of a particular value

over time. For example, you could use a

line graph to plot the cost of repair for the

past four years. The graph helps you

visualize how the cost of repair has been

increasing or decreasing over time.
Area

Stacked Area Comparing the trend of multiple values

over time. For example, you could use a

stacked line graph to plot the cost of

repair and the cost of operator training

for the past four years. The graph helps

you visualize if the increase in the cost of

operator training leads to a decrease in

the cost of repair.

Heat Map Graphs

Heat Map Displays data using a range of colors to

give an immediate visual summary of

values to identify trends and potential

problems.

Create a Graph

Procedure

1. Access a Graph.
2. In the upper-right corner of the page, select Create New.

The Data Source workspace appears.
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3. Select the data source for the graph.
4. Specify the dimensions for the graph.

5. In the upper-right corner of the page, select .

Tip: You can also select  to save the graph in a different location.

The graph is created, and stored in the specified Catalog folder.

Copy a Graph

About This Task

This topic describes how to copy a graph to a different Catalog folder.

Note:

• You can copy a graph into a Catalog folder only if you have Create permissions for that folder. You
cannot, however, copy a graph into a Baseline folder.

• For more information on the Catalog page, refer the Catalog module documentation.

Procedure

1. Access the Catalog page for the folder containing the graph that you want to copy.
2. Select the check box that corresponds to the graph that you want to copy.

3. In the upper-right corner of the workspace, select .

The Catalog Folder Browser window appears.
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4. Navigate to the folder where you want to copy the graph, and then select Done.

The graph is copied to the selected folder.

Select a Data Source

About This Task

To create a graph, you must select one of the following types of data sources from the Catalog:

• Queries
• Datasets

This topic describes how to select or modify a data source for a graph.

Procedure

1. Access the graph for which you want to specify or modify the data source.
2. In the left pane, select Data Source.

The Data Source workspace appears.
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3. Next to the Query Path or the Dataset Path box, select .

The Select a query, or a dataset from the catalog window appears.

4. In the left pane, navigate to the folder that contains the query or the dataset that you want to use as
the data source.

5. Select the query or the dataset, and then in the lower-right corner of the window, select Open.

Note: If the query that you have selected contains a prompt, then a window appears, displaying the
prompt. Provide the required values, and then select Done.
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The Query Path or the Dataset Path box is populated with the folder path of the query or the dataset
that you selected.

If you have selected a query, then the results of the query appear in the workspace.

-or-

If you have selected a dataset, then the values in the dataset appear in the workspace.

Important: The changes are saved only after you specify the graph dimensions, and then select .

Next Steps

• Specify Graph Dimensions

Modify the Graph Type

Procedure

1. Access the graph for which you want to modify the graph type.

2. In the left pane, select Graph Type.

The Graph Type workspace appears.

3. Select the type of graph that you want to use. The bar graph is selected by default.
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For example, if you want to change the graph type to a pie graph, select .

4. In the upper-right corner of the page, select .

The graph type is changed.

About Graph Dimensions
The Data Source workspace displays a list of the columns or fields that exist in the underlying query or
dataset. The graph dimensions will adjust automatically based on your settings.

Suppose you have a query with the following results:

Equipment Technical Number Total Cost Maintenance Cost

G0010A-074 1690651 386387

G0003-092 1341803 228380

G0010B-074 1166331 312371

GC0030-091 1046865 175728

G0016-092 975146 369122

A graph that you build from this query could display the Bad Actors by total cost, as shown in the
following image:

...or both total cost and maintenance cost for each asset, as shown in the following image.
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Specify the Graph Dimensions

Before You Begin

• Select a data source.

Procedure

1. Access the graph for which you want to specify the graph dimensions.
2. In the left pane, select Dimension Mapping.

The Dimension Mapping workspace appears.

Note: If you are mapping the dimensions for a heat map or color scale graph, you will be mapping
columns instead of a series.

3. In the Vertical Axis Values section, select Map Series.

The Dimension for Series window appears.

Note: If you are creating a color scale graph, the Vertical Axis Value must be taken from the query
column that returns the name of the color displayed on the color scale. The logic for determining the
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color for each row of query results should be embedded in the query itself using any valid HTML color
name or code. For example, the following query determines colors based upon the value of another
column:

SELECT [MC_MTCRD].[MC_MTCRD_TIME_STAMP_D] "Timestamp" 
, Decode([MC_MTCRD].[MC_MTCRD_VALUE_C], 'RUNNING', Green', 
'INFEEDHOLD', 'Yellow', 'DOWNLOADING', 'Yellow', 'ABORTED', 'Red', 
'Orange') "Color" 
FROM [MC_MTCRD] ORDER BY [MC_MTCRD].[MC_MTCRD_TIME_STAMP_D] Asc 

4. Select the dimensions that you want to plot on the vertical axis, and then select Apply.

The selected dimensions appear in the Vertical Axis Values section.
5. In the Category section, select Map Category.

The Dimension for Category window appears.

Note: If you are creating a time series graph, the Dimension for Category must be time stamp.
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6. Select the category that you want to plot on the x-axis, and then select Apply.

The selected dimension appears in the Category section.

7. Select .
8. If you have created a new graph, in the Save As window that appears, in the pane, navigate to the

catalog folder in which you want to save the graph, provide the details of the graph, and then select
Save.
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-or-

If you have accessed an existing graph, in the window displaying confirmation that the graph is saved.
Select OK.

The changes made to the graph dimensions are saved.

Note: For pie charts, you can localize the labels on the slices from a system code table or a family
state machine. You can do so using the options that are available in the Category section of the
Dimension Mapping workspace.

If you selected a system code table and the value in the Category section matches a code in the
specified system code table, the localized description value from the table will be used to display the
label. Similarly, if you selected a family for which state management is enabled and the value in the
Category section matches a state ID in the specified state machine, the localized state caption will be
used to display the label.

Access the Query or Dataset Associated with a Graph

Before You Begin

• Select a data source for the graph.

Procedure

1. Access the graph whose query or dataset you want to access.

2. In the upper-left corner of the Graph Result workspace, select .

The query or dataset appears.

Refresh a Graph

About This Task

You can refresh a graph to ensure that the graph is displaying the most recent database information and
configuration options. For example, you might want to refresh the graph to rerun the associated query, or
to see the effect of adding a record to the database.

Note: If the underlying query contains a prompt, the prompt will be displayed after you refresh the graph.
You will need to provide the prompt values after refreshing.

Procedure

1. Access the graph that you want to refresh.

2. In the upper-left corner of the Graph Result workspace, select .

The graph refreshes to display the most recent information.

About Hyperlinks on Graphs
You can add hyperlinks to a graph to access any GE Digital APM module addressable via a URL or an
external website. When a hyperlink has been added to a graph, selecting a datapoint on the graph will
display the location defined for the link.
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Note: If you add a hyperlink to a pie, doughnut, or a pyramid graph, the URL will not trigger when you
select a datapoint on the graph.

When you add a hyperlink to a graph, you can configure it such that when you select a datapoint on the
graph, a specific value from the graph will be passed in as a parameter value to the URL. You can pass any
of the following values into the URL:

• The vertical value of the selected datapoint
• The x-axis value of the selected datapoint
• The value stored in a specific field in the record associated with the selected datapoint
• The Family Key of the record associated with the selected datapoint
• The Entity Key of the record associated with the selected datapoint
• All the values for any previously accessed graph

Add a Hyperlink to a Graph

Before You Begin

• Create a hyperlink for the query to which you want to add the hyperlink.

Procedure

1. Access the graph for which you want to add a hyperlink.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.

3. Select the Series tab.

The Series section appears.
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4. In the Pick an axis box, select the axis to which you want to apply a hyperlink.
5. In the Hyperlink box, select the hyperlink that you want to add to the axis that you have selected.

The hyperlink is added to the graph.

About the Vertical Axis Scales
When you choose a column or field to be plotted on the y-axis, you must specify the side of the graph on
which the axis will appear: left or right. You can do so using the options that are available in the
Dimension Mapping workspace.

If you choose to plot more than one column or field on the y-axis and the values in those columns or fields
vary greatly, using a right and left y-axis can improve the usability of the graph.

Suppose you have a graph with the following underlying data:

Equipment Technical
Number

Total Cost Maintenance Cost Production Losses

G0010A-074 1690651 386387 1304264

G0003-092 1341803 228380 1113423

G0010B-074 1166331 312371 853960
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Equipment Technical
Number

Total Cost Maintenance Cost Production Losses

GC0030-091 1046865 175728 871137

G0016-092 975146 369122 606024

In this example, if we plot a graph with multiple vertical axis values, it allows you to compare total cost,
maintenance cost, and production loss, which provides a fuller picture of your assets.

Specify the Limits for Vertical Axis Values

Procedure

1. Access the graph for which you want to specify the limits for vertical axis values.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.
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3. Select the Axis tab.

The Axis section appears.
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4. Provide the minimum and maximum values in the Minimum and Maximum boxes respectively.

The graph refreshes to plot only those values that fall in the limits that you have specified.

Specify the Format of the Vertical Axis Values

Procedure

1. Access the graph for which you want to specify the format for vertical axis values.
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2. In the upper-right corner of the workspace, select .

The Settings pane appears.

3. Select the Axis tab.

The Axis section appears.
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4. In the Format box, select the format for the vertical axis values.

The graph is refreshed to plot the vertical axis values in the specified format.

Specify the Number of Decimals for the Vertical Axis Values

Procedure

1. Access the graph for which you want to specify the number of decimals for the vertical axis values.
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2. In the upper-right corner of the workspace, select .

The Settings pane appears.

3. Select the Axis tab.

The Axis section appears.
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4. In the Decimals box, select the number of decimals for the vertical axis values.

Note: If the value in the Format field is None, then the vertical axis values do not contain decimals.

The graph is refreshed to plot the vertical axis values with the specified number of decimals.
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Convert to a Three-dimensional Graph

About This Task

When you create a graph, by default, it is plotted as a two-dimensional graph. This topic describes how to
convert it to a three-dimensional graph.

You can view a three-dimensional graph only for the following types of graphs:

• Bar graphs
• Pie graphs

Procedure

1. Access the graph for which you want to specify the number of decimals for the vertical axis values.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.

3. In the Graphs section, select the 3D check box.

The graph is refreshed to display in a three-dimensional view.

Tip: If you want to covert the graph to a two-dimensional view, clear the 3D check box.
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Show or Hide the Legend

Procedure

1. Access the graph for which you want to show or hide the legend.

2. In the workspace, select .
The Settings pane appears.

3. To view the legend at a specified location or hide the legend, follow these steps:

a) To specify the location for the legend, in the Legend drop-down list box, select a location.
The graph is refreshed, and the legend appears at the selected location.

b) To hide the legend, in the Legend drop-down list box, select Hide Legend.
The graph is refreshed, and the legend is hidden.

Note: For pie charts, you can position the legend only at the top of the Graph Result workspace.

Show or Hide Grid Lines

Procedure

1. Access the graph for which you want to show or hide the grid lines.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.

   

34  © 2020 General Electric Company



3. Select the Axis tab.

The Axis section appears.
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4. If you want to show the grid lines, select the Grid Lines check box.

The graph is refreshed to display the grid lines.
5. If you want to hide the grid lines, clear the Grid Lines check box.

The graph is refreshed to hide the grid lines.
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Enable or Disable Logarithmic Scale

About This Task

The Logarithmic Scale option allows you to specify that you want to display values as logarithm, and
displays the values on the graph on a more manageable scale.

Procedure

1. Access the graph for which you want to enable or disable the logarithmic scale.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.

3. Select the Axis tab.

The Axis section appears.
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4. If you want to enable the logarithmic scale, select the Logarithmic check box.

The graph is refreshed to reflect the logarithmic scale.
5. If you want to disable the logarithmic scale, clear the Logarithmic check box.

The graph is reverted to its original scaling.

Example

For example, the following image shows a graph whose values on the scale are
displayed using the Number format option when the Logarithmic box is cleared.
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If you were to select the Logarithmic box, the same graph would appear as shown in
the following image.
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Show or Hide the Labels of a Graph

Procedure

1. Access the graph for which you want to show or hide labels.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.
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3. If you want to view the vertical axis labels, in the Graphs section, select the Show Labels check box.

The graph is refreshed to show the vertical axis labels.
4. If you want to view the x-axis labels, in the Graphs section, select the Show X-Axis Labels check box.

The graph is refreshed to show the x-axis labels.
5. If you want to hide the vertical axis labels or the x-axis labels, clear the Show Labels or Show X-Axis

Labels check box, respectively.

The graph is refreshed to hide the labels.

Show or Hide the Scroll Bar

Procedure

1. Access the graph for which you want to show or hide the scroll bar.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.
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3. If you want to view the scroll bar, in the Graph section, select the Show Scroll Bar check box.

The Maximum amount of points to show box appears.
4. In the Maximum amount of points to show box, enter the number of points that you want to view

per page.

The graph is refreshed to show the specified number of points per page. You can use the scroll bar to
view the rest of the pages.

5. If you do not want the scroll bar, in the Graphs section, clear the Show Scroll Bar check box.

The graph is refreshed to show all the points on a single page.

Show Full Graph Labels

About This Task

The labels that appear on graphs are truncated by default. If necessary, you can modify the graph settings
to show the full-length labels.

Note: Depending on the size of your graph and the size of your screen, full-length labels may distort your
graph and make it illegible.

Procedure

1. Access the graph for which you want to show full-length labels.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.
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3. In the Graph section, clear the Truncate Labels check box.

You can now see the full-length graph label.

Modify the Name, Caption, and Description of a Graph

About This Task

When you create a graph, you provide the name, caption, and description of the graph, and store it in the
Catalog. This topic describes how to modify these properties by accessing the graph from the Catalog.

To modify Catalog item properties, you must have View and Edit permissions to the folder.

Note:

• If you transfer ownership of a Catalog item to another user, but the item resides within a folder to
which that user does not have View permissions, the user will not be able to view the Catalog item.

• For more information on the Catalog page, refer the Catalog module documentation.

Procedure

1. Access the Catalog page for the folder containing the graph whose properties you want to modify.

2. In the row for the graph whose properties you want to modify, select .

The Catalog Item Properties window appears, displaying the properties for the selected graph.
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3. As needed, modify values in About Catalog Items window, and then select Done.

The properties for the selected graph are modified.

Modify the Colors of a Graph

Procedure

1. Access the graph for which you want to modify the colors.

2. In the upper-right corner of the workspace, select .

The Settings pane appears.
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3. Select the Series tab.

The Series section appears.
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4. In the Color box, select the color that you want to apply.

Tip: If the color that you want to apply is not available, select More, select the color, and then select
Choose.

The selected color is applied to the series that you have specified in the Pick a series to edit box.

Make a Prompt Appear on a Graph

About This Task

To make a prompt appear on a graph, you must create the prompt for the query that is used to generate
the graph.

Procedure

1. Access the Prompt Settings section of the query that is used to generate the graph.

Note: For more information on the Prompt Settings section, refer the Queries module documentation.
2. Create any of the following prompts for the query:

• Create a Prompt with No List of Valid Values
• Create a Prompt with a Static List of Valid Values
• Create a Prompt with a List of System Codes
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• Create a Prompt with a List of Query Results
• Create a Prompt with a List of Values from a Record
• Create a Prompt on a Logical Field

The prompt is created for the query. When you access the graph, the prompt appears.

Note: For more information on creating a prompt, refer the Query Expressions, Clauses, and Prompts
section, in the Queries module documentation.

Export a Graph
You can export a graph to a PDF document.

Procedure

1. In the module navigation menu, select Tools > Graphs.
The Graphs page appears.

2. Select Browse, and then select a graph from the catalog.
3. Select Open.

The selected graph appears in the Graph Result workspace.

4. Select  .
The Print window appears.

5. Select Save as PDF as the destination, and then select Save.
The Save As window appears.

6. Select a location for the file and enter a file name, and then select Save.
The graph is saved as a PDF document to the selected location on your local drive.

Delete a Graph

Procedure

1. Access the Catalog page, for the folder that contains the graph that you want to delete.

Note: For more information on the Catalog page, refer the Catalog module documentation.
2. Select the check box that corresponds to the graph that you want to delete.

3. In the upper-right corner of the page, select .

A confirmation message appears, asking if you really want to delete the graph.
4. Select OK.

The graph is deleted.
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Chapter

4
Reference
Topics:

• Graph URLs
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Graph URLs
There are two URL routes associated with graphs: graph and graph-preview. The following table describes
the various paths that build on the route, and the elements that you can specify for each.

Element Description Accepted Value(s) Notes

graph: Displays the Graphs page.

<Catalog Item Key> Specifies the Catalog Item Key

of the graph that you want to

open in the Graph tool.

Numeric Catalog Item Key #graph/Catalog Item
Key

<Catalog Item Path> Specifies the path and name of

the graph that you want to

open in the Graph tool.

Catalog item path #graph?path=Catalog
Path\Graph name

p0, p1, p2 etc. (specifying a

literal value)

Specifies a literal value that

will be passed into a graph

containing a prompt.

Any value that is acceptable

for the prompt type (e.g.,

numeric values for numeric

prompts)

#graph/Catalog Item
Key?p0=Literal
Value
#graph?path=Catalog
Path\Graph
name&p0=Literal
Value

p0, p1, p2 etc. (specifying a

variable value)

Specifies a variable value from

a specified column key in a

graph that will be passed from

a query into a graph containing

a prompt.

Any value that is acceptable

for the prompt type (e.g.,

numeric values for numeric

prompts)

#graph/Catalog Item
Key?p0={Column
Key}
#graph?path=Catalog
Path\Graph
name&p0={Column
Key}

graph-preview/<Catalog Item Key>: Displays the graph in a new, view-only page.

Parameter Name = Parameter

Value

Specifies the Parameter Name

and Parameter Value of the

query that you want to open in

a new, view-only page.

Parameter Names and

Parameter Values
#graph-preview/Catalog
Item Key?

Parameter
Name=Parameter
Value
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Example: Graph URLs

Example URL Destination

#graph/3223198 Opens the graph with the Catalog Item Key of 3223198 in the

Graph tool.

#graph?path=Public\Meridium\Modules
\Core\Graphs\APM Graph

Opens the graph named 'APM Graph' in the Graph tool that is

found in the specified Catalog folder.

#graph/3223198?p0=Literal Value Opens the graph with the Catalog Item Key of 3223198 in the

Graph tool and passes the specified literal value into the first

prompt of the query associated with the graph.

#graph?path=Public\Meridium\Modules
\Core\Graphs\APM Graph&p0=Literal
Value

Opens the graph named 'APM Graph' in the Graph tool that is

found in the specified Catalog folder and passes the specified

literal value into the first prompt of the query associated with

the graph.

#graph/3223198?p0={1} Opens the graph with the Catalog Item Key of 3223198 in the

Graph tool and passes the specified variable from an existing

query into the first prompt of the query.

#graph?path=Public\Meridium\Modules
\Core\Queries\APM Graph&p0={1}

Opens the Query named 'APM Query' in the Query tool that is

found in the specified Catalog folder and passes the specified

variable value from an existing query into the first prompt of the

query.

#graph-preview/64261561529?Site=MI-ASM-
SC&Area=MI-ASM-A007&Unit=MI-ASM-
U0071

Opens the graph with the Catalog Item Key of 64261561529,

Parameter Name Site, Parameter Value MI-ASM-SC, Parameter

Name Area, Parameter Value MI-ASM-A007, Parameter Name

Unit, and Parameter Value MI-ASM-U0071 in a new, view-only

page.
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